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GENERAL INFORMATION 

This User Guide is presented for training and as a future reference.   

Contact your Regional Audiologist or their representative for clarification and further guidance if there are 
any inconsistencies between this guide and your test site processing. 

Figures (screen shots) throughout this guide may differ slightly from your desktop depending on the 
Operating System, DOEHRS-HC software version/update and the audiometer set up.  Functions are similar. 

The word Training is in many of the fields throughout this guide and in the training databases.  Do not use 
“training” at the active testing site when testing actual patients.   

Each chapter builds on previous chapters, information, practicums and/or final practical exam. It is very 
important that you do not miss any classes. 

DOEHRS-HC software (user/password-restricted) is a storage database for administrative documents and patient 
data.  Fill out all sub-fields (Examiner, UIC, Audiometer, and Listener) correctly or the number of tests conducted will 
multiply data entry errors.  When discussing DOEHRS-HC we are talking about the software application on the local 
computer; DOEHRS-DR (Data Repository) is the web-based application.  Recommend using the tab (not mouse) when 
inputting data in DOEHRS-HC until familiar with DOEHRS-HC data entry, so that every required field will be fill out.  
Previous drop down window selections will affect upcoming drop down choices. 

The CCA-200 software is integrated within the DOEHRS-HC software and is used for audio testing only.  Prior to 
retrieving data from the CCA-200 to DOEHRS-HC, review the threshold levels for accuracy and retest frequencies that you 
suspect have issues and/or problems. 

UIC Locator is a database of UICs from DMDC.  Most patients will not know what their UIC is.  Get enough 
information so you can find, enter and/or select the correct UIC for the patient.  The Unit Identification Codes (UIC) drives 
most Hearing Conservation Program Reports.  Use the Defense Manpower Data Center (DMDC) file as the source document 
for UICs.  

Ensure the sound volume on your computer is set at an acceptable level for your patients (single left click on speaker 
icon on the tool bar and adjust the volume).  The instructions are in a wave file.  Ensure the wave file on the Master Volume 
Control is not muted (double left click on the speaker icon on the tool bar). 

Ensure power to the audiometer is off when disconnecting/connecting the audiometer to the computer. 

 

 

 

 

 

 

 

 

Theodore Mason, Information System and Training Specialist (USN); 757-953-0772 

theodore.d.mason.civ@mail.mil 

  

mailto:theodore.d.mason.civ@mail.mil
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Everyday when the DOEHRS-HC application is initially opened, referrals may have been created in you local 
database due to non-return of patients requiring follow-up testing.  Positive STSs change to a Permanent STSs if 
follow-up testing is not conducted within the service specific timelines.  These timelines may be 30, 60 or 90 days 
(depending on DoD and Service Component) to complete their follow-up testing on positive STS periodic tests.  You 
will need to go though the following series of pop-up windows with each of these patients.  Referral generated ‘OK’, 
Save the referral ‘YES’, Referral was saved ‘OK’,. Referral will only appear once at application start-up, ensure you 
save the referral. 
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DOEHRS-HC USER ACCOUNT 

Class 20 minutes/Practicum 10 minutes 

This lesson describes the steps necessary to add yourself as an active user with Hearing Conservation Program 
Manager (HCPM) privileges into the DOEHRS-HC software.  A user with HCPM privileges needs to be logged into 
DOEHRS-HC in order to add new users.  Only authorized certified technicians can perform audio testing and they are 
required to test under their user identity.  Add your user identity into each DOEHRS-HC database (Testing Site) where you 
will perform audio testing.   

DO NOT CREATE OR HAVE INVALID (Backdoor) USER IDENTITIES IN DOEHRS-HC FOR ANY REASON. 

Open DOEHRS-HC software training database with User ID: SMITHAE (local HCPM privileged user).  Press OK, 
User SMITHAE does not have a password. DO NOT ENTER a password in the Login window.  Password is case 
sensitive.  For training purposes, enter Qwerty1234567890_ into the Change Password window. 

       

Initializing Audiometer Hardware window and several additional pop-up windows may appear when the application 
opens, read and become familiar with them.  To add an “active user” into an existing database go to File>Users. 

        

The User window will appear. Several functions happen in this window.  Lock and unlock individual accounts; 
Add and delete (deactivate) user accounts; User privilege selection (HCPM or Examiner) USN users will select or be 
entered as HCPM; Clear passwords (case sensitive/require change every 60 days); active users in the drop down window. 
Students: add yourself as a new user: in the Select a Record drop down window select “New User”.  Recommend you 
get a DOEHRS-DR account (user name issued) prior to adding yourself into the local DOEHRS-HC system, you could then 
select the same user name that the DR will issue you. 

Following is a User with Examiner Privileges.  Observe the restricted areas (grayed out and highlighted) if a user is 
entered in DOEHRS-HC with examiner privileges. 
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You need to apply for a DR User account with your CAC.  Once your DR user account is approved DOEHRS-HC 
(if connected to the network) will communicate directly to the DOEHRS-DR via your CAC thru the software. You will need 
this access (connected to the net or not) to conduct monthly updates, upload records, DR Inquires, etc. 

To change Login without closing DOEHRS-HC Go to File>Change Login 

       

The DOEHRS-HC software will lock your account if you try to open the software 3 times with an incorrect 
password, including if you enter a password on a “cleared/blank password” or if you close/reopen the application.  If you 
lock yourself out, get another HCPM to log in and unlock your account.  Go to the User window; find the locked user identity 
press Unlock Account to unlock/clear password.  You can also contact the MHS help desk (CONUS = 1-800-600-9332; 
OCONUS = 1/866/637/8725) to get a password which will allow one time access into DOEHRS-HC. 

    

For training purposes, enter your last name (uppercase) as your User Name.  Select HCPM as your privilege.  
Click on the “3 dot” icon next to the Training Cert. No field.  The Examiner data window will appear. 
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Fill out your personal information correctly, enter your personal information (name/SSN); proper name, 
example: Joseph, not Joe, J, Joey, correct SSN, etc. Enter Training for the office symbol.  

Testing facility is: 68546A (NMCPHC Training)  

The field that will change for each test site is the Testing Facility UIC (where the audio testing booth is 
located).  Enter training certification number 1589xxN.  xx = student number given to you by the instructor 01, 02, 03 
etc.  The N is required to be uppercase and stands for a Navy sponsored training course (does not matter what service 
you belong to).  Once complete press “Save”.  

    

Look in the Select a Record drop down window to display the active users.  Previously displayed were three active 
users in the database.  How many active users are in your database?  _____ 

If you are going to input a DD Form 2215 for an audiologist, get all their examiner data (personal information) prior 
to entering them as users into the database.  Get their full name (spelling); SSN, DOEHRS-HC certification number, grade, 
testing location, etc Audiometer information with model, serial number, calibration date and testing location will also be 
required. 

Students log in under your User account.  Go to File>Change Login.  The Login screen will appear.  Type in 
your User name and press OK.  The Password verification screen will appear.  For training purposes, use 
Qwerty1234567890_ as your password. 
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DOEHRS-HC USER ACCOUNT QUIZ 

1.  Why do we recommend getting a DOEHRS-DR account prior to entering your user identity into DOEHRS-HC? 

 

2.  How many incorrect tries do you have to log into the DOEHRS-HC before you lock your account? 

 

3.  How many users should be in the local DOEHRS-HC software? 

 

4.  How can I get my DOEHRS-HC account unlocked? 

 

5.  How does DOEHRS-HC communicate with DOEHRS-DR? 

 

6.  What areas are restricted (access denied) as a user with “examiner” privileges? 

 

7. How frequently is it required that you change your DOEHRS-HC or DOEHRS-DR user password? 

 

8. Why shouldn’t a back-door user identity in DOEHRS-HC be created? 
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FUNCTIONAL CHECK 

Class 15 minutes/Practicum 5 minutes 

This lesson describes the steps necessary to conduct a Functional Check.  The Functional Check is a “hands-on” 
equipment check performed daily by the Hearing Conservation Technician prior to any patient testing.  The purpose is to 
ensure equipment is working properly and to detect any hardware (response switch, headphones, wiring and audiometer) 
problems before patient testing.  Any problems need to be resolved prior to using the equipment.  Declare the individual 
station inoperative if the problem cannot be resolved, even if it passes daily calibrations (covered in another lesson).  The 
audiometer and headset are calibrated together and have matching serial numbers.  Never separate the headset from the 
audiometer for patient testing. 

Normal hearing is required to conduct a Functional Check.  This lesson assumes you have opened the 
DOEHRS-HC application and have access to the CCA-200 software.  It also assumes there were no hardware or software 
error messages.  Any error messages must be resolved prior to conducting the Functional Check. The number of audiometers 
you have attached to your computer should match the number of audiometers in the Run Test and CCA-200 window. 

 

Complete Functional Checks daily, prior to any audiometric testing.  Additional checks may be required if you 
suspect any hardware problems.  In the CCA-200 window go to Audiometer>Functional Check.  The Functional Check 
window will appear. 

DO NOT PRESS THE START BUTTON IN THE FUNCTIONAL CHECK WINDOW 

To perform a Functional Check correctly, enter the booth; place the red headphone on the right ear and the blue 
headphone on the left ear.  Press the hand switch (one time) to start the Functional Check for that station.  If the Functional 
Check does not start or you need to press very hard on the response switch to get it started, you need to check the hand 
switch.  You can visually ensure your response switch is working properly by pressing/releasing the response switch and 
ensuring the yellow light on the audiometer is corresponding with your actions.  If the response switch is defective, replace it. 

The Functional Check will always begin in the left ear; automatically sweeping the frequencies at 60 decibels.  The 
frequencies presented in the left ear in the following order: 500Hz, 1000Hz, 2000Hz, 3000Hz, 4000Hz and 6000Hz.  Listen 
carefully for distinct and separate frequencies.  Tones should sound solid and pure, not distorted or have static/hum.  Pressing 
the response switch again while a tone is present will repeat that tone. 
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The software will then sweep the intensity range in the right earphone, 70dB to 0 dB in 10 dB increments.  Listen 
carefully for distinct and separate intensities.  Tone presentation will be presented at 1000 Hz and begin at 70 decibels.  It 
will drop at 10 dB intervals.  At 0 dB, the software will automatically switch over to the left ear and present a steady 60 dB 
tone.  If you have any problems with this portion of the Functional Check, such as no tones in either ear, check the wiring 
connections (fixable).  Replace headset wiring if needed.  Check and clean the RCA jacks.  You may also have hardware 
problems with the audiometer, for example, skipping tones or blending (not repairable at your level).  Ship audiometer (if 
USN) to the Navy Marine Corps Public Health Center (Calibration Lab) with the headset for repair or contact Benson 
Medical Instruments if under warranty. 

      

While the left earphone emits the steady 60 dB tone wiggle the headset cable, both at the jack and the headset.  
Listen for static (crackle sounds) or intermittent tone presentation.  Pull the left earphone away from your head and 
cover it.  You should not hear anything in your right ear (leakage/crossover).  Put the earphone back on your ear and 
press the hand switch.  The tone will switch over to the right ear. 

       

Wiggle the wires and conduct the same test on the right ear as you just conducted on the left ear.  Ensure you 
check for crossover by pulling the right earphone away from your head and covering it.  You should not hear 
anything in your left ear.  Replace the headset on properly.  Press the hand switch several times; the tone should 
switch from ear to ear with each press.  If you have similar hearing with both ears these tones should sound 
approximately the same.  If you have to press very hard or several times to get the tone to switch, you may have a bad 
hand switch (do a visual check) or patch cord. 

Replace the headband if the earphone does not remain on the ear without physical assistance (holding it in place) or 
loose tension.  While listening to the steady tone and wiggling the cord (both locations) you hear static, breaks and/or 
crossover the headset wiring may require replacement.  Replace the ear cushion if it is stiff, pitted and/or cannot be cleaned.  
Do not get any moisture on the diaphragm (black piece that tones come out of). 

Additional Functional Checks may be required if you notice problems with the same station during patient 
audio testing.  Once the Functional Check is completed, press “Stop” or “Close”. 
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Multi-station booths require each station to be done individually.  On a multi-station booth, an additional pop up 
screen will appear when stop is pressed.  It will ask which audiometer to stop.  Select “All Enabled Audiometers” and then 
close the Functional Check.  Conduct a Functional Check on all audiometers no matter what your workload is for that day.  
Once the Functional Checks are complete, the equipment is ready for the daily calibration check.  Set your equipment up for 
the daily calibration check. 

    

You will conduct Functional Checks several times throughout the week. Have students conduct a functional 
check. 

 

FUNCTIONAL CHECK QUIZ 

 

1.  How do you start the Functional Check? 

 

2.  The Functional Check started on the right ear, what do you need to do? 

 

3.  Why is it important to conduct a Functional Check? 

 

4.  How do you check for leakage/crossover? 

 

5.  Functional Checks are required daily.  When would you conduct it more than once a day? 

 

6.  What are you listening for when you conduct a Functional Check? 

 

7.  What type of hearing should the Hearing Conservation Technician have if they are going to conduct a Functional Check? 
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AUDIOMETER CALIBRATIONS 

Class 20 minutes/Practicum 10 minutes 

This lesson describes audiometer calibrations and the steps necessary to conduct a daily calibration check also 
known as a Biological Calibration Check.  Perform a successful Functional Check prior to conducting the Daily Calibration 
Check.  The Calibration Check is a “sound level output test” conducted using an electronic device: Sound Level Meter 
(SLM) or Bio-Acoustic Simulator (BAS).  The purpose is to ensure the audiometers’ sound level output is within specified 
levels of the audiometers established baseline.  Electro-Acoustic Calibrations are required annually.  Ensure power to 
the audiometer is off when disconnecting/connecting the audiometer to the computer.  Audiometers may be shipped 
for electro-acoustic calibration. You will be unable to conduct audio testing if the electro-acoustic calibration is out of 
date.  Immediately after completion of annual calibration establish a baseline per audiometer/listener (BAS).  
Primary/Alternate listener (BAS) baselines are required.  Listener(s)/audiometer with established baselines are not 
interchangeable.  Any problems that surface need to be resolved prior to using the equipment.  If the problem cannot be 
resolved, the equipment is inoperable even if it passed the Functional Check.  The audiometer and headset (calibrated 
together) have matching serial numbers.  Never separate the headset from the audiometer for patient testing.  Perform 
Biological Calibration Checks daily prior to patient testing.  Results are recorded on a DD Form 2217 and retained 
for 5 years (.pdf is acceptable). 

This lesson assumes you have opened the DOEHRS-HC software and have the Benson Medical Instruments CCA-
200 window available.  It also assumes there were no hardware or software error messages.  Any error messages must be 
resolved prior to conducting the Daily Calibration Check. 

Two station booth configuration displayed, note the station number in the run test screen is italic and grayed 
out this means that the calibrations were not done and/or retrieved successfully into the run test screen. 

 

After conducting the Functional Check, prepare the hardware (audiometer and BAS) to conduct the Daily 
Calibration Check.  Have students follow along to conduct a calibration test.  Place the headphones on the bio-acoustic 
simulator (BAS-200 or ME-500).  Center each earphone directly over the microphone.  Place the right earphone on 
the red side of the BAS and the left on the blue side.  Headband is parallel to the face of the BAS, yolk completely 
tightened, providing the most amount of tension. 
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At test sites, the simulator is wall mounted inside the booth.  The audiometer is directly behind the BAS.  The patch 
cord links the BAS and audiometer together.  Connect the patch cord from the audiometer “response jack” to the simulator 
“audiometer jack”.  The simulator operates with power supplied from the audiometer.  Removal of the response switch from 
the BAS will activate the BAS for calibration mode. 

Displayed in the following figures: (left figure) BAS power light is not on with the hand switch plugged in 
(inactivated BAS cannot respond to the daily calibration test).  Removed the hand switch (right figure), the power light is 
on and activates the BAS to respond to the calibration test.  Have students pull the hand switch out and ensure the 
BAS light turns on.  Hardware is now prepared for daily calibration testing.  Make certain you conduct the daily calibration 
tests with the audio booth door(s) closed. 

    

Electronic Bio-Acoustic Simulators (BAS) do not have normal hearing.  Threshold levels can be between 50 to 
85dB.  The decibel level does not matter as long as the Daily Calibration results are within specified levels of the 
audiometer/listener baseline.  Specified levels for successful Daily Calibrations are within +/- 5dB at 500 thru 4000 
frequencies and within +/- 10 dB at the 6000 frequency current calibration test compared to the previous established 
audiometer/listener baseline. 

If there is not a check in the Daily Calibration box (lower left portion of CCA-200 window) then application is not 
currently set up to conduct Daily Calibration test.  To set the software (CCA-200) to perform a calibration check/test in a 
single station booth place a check in the Daily Calibration block on the Audiometer tab or go to Audiometer>Daily 
Calibration>Set. 
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When the Daily Calibration block is checked, software is set up to conduct the Daily Calibration test on the 
audiometer(s).  There are multiple ways to conduct the same function (Start Test) with the CCA-200 software (icon, 
menu, right click on the individual test station line for the menu, hot key – F4). 

     

For training purposes ensure audiometer wiring is out of the way and limit student movement so the classroom is 
quiet while the Daily Calibration test is running.  At the test site, close the audio booth door(s) while the test is running.  
Have the students’ start the calibration test and select the 4000 Hz to retest while right ear is being tested. This will 
demonstrate how to retest frequencies by highlighting the threshold levels (left click) while the test is running. 

  

All Daily Calibrations threshold results will compare to the baseline you are conducting or have established.  
Always review calibration thresholds while the test is running and stop or highlight those audiometer frequencies that 
are having problems.  Calibration test are retrieved automatically upon test completion.  On a single station booth, 
you have the ability to retest certain frequencies prior to test completion.  On a multi-station booth, once the first test 
is finished and the listener window pops up you will not be able to re-test any of the other stations frequencies.  If you 
press cancel (individual station), results will not be retrieved into DOEHRS-HC.  In either case, pressing OK or 
Cancel will erase the calibration results from the CCA-200 window. Troubleshoot equipment and retest if audiometer 
failed calibrations.  Do not use the equipment if it continues to fail calibrations. 

Review the threshold levels in the next figure.  2000Hz on the right ear responded at 30dB, this is definitely 
inaccurate because the BAS does not “hear” that low.  Establish these results as the calibration baseline would result with 
consistent future daily failed calibration tests.  Retrieving these threshold levels would result in future unsuccessful daily 
calibrations.  If you left click and highlight the 2000 frequency while testing is in progress, it will be retested. 
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Calibrations are complete when all frequencies have threshold levels locked in.  PRIOR TO PRESSING 
“CANCEL” IN THE LISTENER WINDOW, write the threshold results below.  Once completed ensure students 
press cancel on the Listener window. 

_____   _____   _____   _____   _____  _____          _____   _____   _____   _____   _____   _____ 

  

Press cancel; do not retrieve results into DOEHRS-HC.  Run daily calibration tests at least twice (changing 
test parameters – take headphones off, pull/re-insert RCA plugs) to ensure consistent threshold levels are used to 
establish a valid baseline.  Ensure thresholds levels meet calibration successful criteria.  You must enter a new listener 
and audiometer when establishing audiometer baselines.  Note Serial/Graphic audiogram displaying threshold levels. 

 

Once retrieved, DOEHRS-HC will compare current threshold levels to the baseline and place them on DD Form 
2217.  Prompts will tell you if the threshold levels are within standard (Successful) or outside standard (Failed) in comparison 
with the audiometer/listener established baseline.  If the daily calibration thresholds are not within standards, troubleshoot 
equipment and rerun the calibration test.  Use the alternate listener if the primary listener continues to fail.  Do not use the 
audiometer if it fails with both listeners (audiometer threshold results continue to be outside the calibration standard).  Send 
audiometer for electro-acoustic calibrations (annual). 

      

Press Cancel once 
thresholds are 
recorded above 
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Daily Calibration test results in the CCA-200 window will immediately clear when you press OK or Cancel in the 
Listener window. 

 

Multi-station booths function similar but have additional windows that appear. 

 

In a multi-station booth, go to Audiometer>Daily Calibration>Set; it will bring up a pop-up screen with all the 
audiometers on it.  Recommend “setting” and conducting a daily calibration on all stations.  Multi-station booths click on 
Audiometer>Start Test; you could also press the start test icon.  Stations will clear individually when listener is chosen or 
canceled. Once the first listener window appears you will not be able to manually highlight (retest) or modify any other booth 
station.  Pay attention to the “Listener” window when doing calibrations on a multi-station booth, calibrations are retrieved in 
the same order as they finish.  

       

AUDIOMETER CALIBRATIONS QUIZ 

1.  Describe how to set up the hardware to conduct daily calibrations? 

 

2.  Describe how to set up the software to conduct daily calibrations? 

 

3.  What do you suspect if the error code “NR” (no response) is present in every frequency? 

 

4.  What do you do if the audiometer fails calibrations? 

 

5.  What are the “specific dB differences from the baseline that are required for “successful” daily calibrations”? 

 

6.  Daily calibrations are recorded on what form and how long are they maintained? 
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ESTABLISHING CALIBRATION BASELINES 

Class 20 minutes/Practicum 10 minutes 

Prior to this class, have the students perform the function check and calibration test in the CCA-200 
software.  Do not select the listener and retrieve results into DOEHRS-HC.  Listener window should be on top.  
Ensure students confirm results are consistent with the results written down in the previous chapter (page 14) or re-
run the calibration test until they are getting consistent results. 

This lesson describes the steps necessary to establish Audiometer Daily Calibration Check baselines.  Establish 
baselines with a both primary and alternate listener for each audiometer immediately following annual calibration.  The 
baselines and daily calibrations are recorded on a DD Form 2217 automatically when retrieved into DOEHRS-HC.  All 
future daily calibration tests compare to the original saved baseline per audiometer/listener.  The daily calibration will “pass” 
if the threshold levels are within established standards.  Ensure you establish good baselines by running the calibration 
test 2 or 3 times; moving the cords and repositioning the headphones (change the parameters of the test)  to ensure 
you are getting consistent results and are creating a good baseline.  Assess results prior to DOEHRS-HC retrieval or 
inaccurate baselines could be established.  Example: if the daily calibration fails constantly since it was established but the 
daily results are consistent you established an inaccurate baseline.  Achieve consistent results then retrieve and establish the 
baseline in DOEHRS-HC.  Established baselines expire in conjunction with the annual calibration. 

This lesson assumes you have opened the DOEHRS-HC software and have access to the DOEHRS-HC run test 
window and the CCA-200 window.  It also assumes there were no hardware or software error messages and that you have run 
(not fully retrieved) daily calibrations at least one time previously.  Function test are also required to be performed and the 
equipment deemed functional. 

If you get an audiometer error: similar to below – serial number xxxxx is not responding when logging into 
DOEHRS-HC the audiometer is not connected properly or the power to the audiometers is off.  Click Cancel and 
troubleshoot.  After you log in, the software will remind you of the need to conduct daily functional and calibration checks 
(unless previously retrieved successfully for that day). 

     

    (multi-station booth)     

The next figure (top of next page) displays the DOEHRS-HC application open.  Software will default to a one-
station booth if there are not any audiometers connected to the computer, otherwise it will configure to the number of 
audiometers attached up to eight.  If the audiometers are not recognized, do not close the DOEHRS-HC application.  Close 
the CCA-200 and the run test windows after you solved the issue and re-open them by going to functions>Run Test / CCA-
200.  Do not just close the CCA-200 window as the configuration of the Run Test window needs to match the CCA-200 
window.  The windows will reconfigure and recognize the hardware when they appear.  Booth numbers in the run test 
window are italic and grayed out (inactive) letting you know function test/daily calibrations need to be successfully 
completed. 
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DOEHRS-HC will automatically retrieve “daily calibration” threshold levels, letting the technician enter or select 
the listener. Calibration thresholds (automatic test only) are retrieved from the CCA-200 window into the Run Test window, 
you do not transfer from the Run Test window to the CCA-200 window for calibration testing.  Upon completion of the 
initial calibration test, the listener window will appear; you will then not have the ability to manipulate any other tests in the 
CCA-200 window.  Results will be cleared in the CCA-200 once the Listener window for that station is closed.  This includes 
closing listener window, cancelling, typing a listener or selecting a listener and pressing OK.  When establishing baselines 
you need to manually type in the “model and serial number” for the listener.  This is important to ensure the accuracy 
of your DD Form 2217.  You only need to enter the listener once per audiometer, after that it will be in the drop down 
window for selection.  Pay attention (multi-station booth) if you are entering listeners to the station number, data is 
retrieved in the order it is completed in. 

      

Enter the listener model that is located on the front of the BAS.  The serial number is also required and is 
located on a silver strip next to the left ear receptacle.  When adding an alternate listener, type ‘Alternate Listener” after 
the serial number.  Establish an alternate listener (different BAS and prior to) in the event the primary listener becomes 
inoperative. 

This establishes a baseline for the audiometer with a specific (primary) listener.  Daily calibrations compare with 
this baseline.  Primary Listener typed in and new baseline established.  Ensure data entered is what was established. 

   

Input the listener, 
example BAS-200;  06759 
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When you retrieve calibrations the software will let you know if the calibration test was successful or if it failed the 
calibration check. 

     

Once the listener/baseline is established, the audiometer is required to be added.  The Add Audiometer window pops 
up automatically after a listener is added.  The Add Audiometer window will appear every time you establish a listener 
(primary/alternate/delete 2217) ensure you enter the data exactly the same.  Serial Number, Model, Manufacturer and 
Calibration date should not require changing.  Add the facility (booth location = clinic) and location (city/state, 
base/country).  Type of audiometer is microprocessor.  Audiologists normally use manual audiometers.  Once the data 
has been entered correctly press “Save”.  This information is recorded on each DD Form 2217, 2216 and 2215 where that 
audiometer is used. If the audiometer is not saved, you will not be able to conduct any testing. 

 

Establish an alternate listener for each audiometer in the event the primary BAS becomes defective. 

   

Once baselines are established for an audiometer, only the listeners previously entered will be in the drop-down 
window available for selection. 
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Once daily calibrations are successful, the station numbers are bold and activated.  If you close the DOEHRS-HC 
application and reopen it later the same day, daily calibrations are not required to be accomplished again.  Recommend doing 
the calibrations again if you suspect a hardware issue during the day. 

  

DD Form 2217s are required to be maintained for 5 years.  You can either print them and maintain hard copies or maintain 
the electronic DD Form 2217 (.pdf files). 

To view, print or export DD Form 2217 go to: Reporting>Forms>DD 2217>All.  Recommend printing or 
exporting the DD Form 2217s the beginning of each month for the previous month.  Select the date range you are 
requesting. 
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Primary and alternate listeners are displayed.  You will need to select one.  Every DD Form 2217s will be displayed 
with the Audiometer Manufacturer, Model, Listener, Facility and Location if previously inputted correctly.  To export the 
form (.pdf file), ensure View>Option “Preview Reports before Printing” is checked. If saved as .pdf recommend placing on 
the shared drive. 

 

There can be minor differences between the daily calibrations and the baseline established.  Successful if the 
calibration is within acceptable limits of the baseline: +/- 5 dB at the 500 – 4000Hz and +/- 10 dB at 6000Hz.  On the next 
figure, note the differences in daily calibrations.   
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ESTABLISHING CALIBRATION BASELINES QUIZ 

1.  What listener data is required on the DD Form 2217? 

 

2. Technicians normally use a manual or microprocessor audiometer? 

 

3. Why are alternate listeners established? 

 

4. What are acceptable limits with daily calibrations/baseline? 

 

5. How many times should you run daily calibrations before creating the “Audiometer Calibration Baseline”? 

 

6. How long are the DD Form 2217s maintained for? 

 

7. How often should the DD Form 2217 be printed or exported for local files? 

 

8. Where should the DD Form 2217 .pdf files be saved to?  

 

9. What should you do if the primary BAS is not functioning properly? 
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UIC LOCATOR 

Class 20 minutes/Practicum 15 minutes 

Most patients do not know what their Unit Identification Code (UIC) is.  You need to be familiar with the local 
UICs tested at that DOEHRS HC Work Station, and be able to look the UIC up if it is not in your DOEHRS-HC database. 

Each service has a unique format for their UIC designed for DOEHRS-HC data entry.  All use alpha/numeric 
characters.  UICs’ are required in DOEHRS-HC and are very important as many DOEHRS-HC reports are derived from the 
patients UIC. 

 Service members fall under their own DOD Component with the exception of USN/USMC.  USN can be under 
USMC UICs and USMC can be under USN UICs. Otherwise USA are under USA UICs, USCG are under USCG UICs and 
USAF are under USAF WICs. 

Format of the DOD Service UICs/WICs in DOEHRS-HC are as follows: 

Air Force has four numbers – four letters – 3 numbers followed by a letter (####-AAAA-###A).  This is a WIC and 
is issued to USAF personnel in the HCP by their IH.  If the USAF patient doesn’t know what their WIC is, USN test sites 
will test them under: 1234-NAVY-123A and type their unit in the location field. 

Army starts with a “W” followed by five alpha and/or numeric characters (Wxxxxx) 

Coast Guard consists of 7 numbers (#######) 

Marine Corps consists of 8 alpha and/or numeric characters (#####x#x) or any 8 character combination of letters 
and numbers 

Navy consist of five alpha and/or numeric characters (xxxxx)  

Query UIC database - Recommend until you get used to the database, put a small amount of information in the 
query and use filter to pull up the answer and re-query when you see how the data/records retrieved are recorded.  Data 
queried needs to be typed exactly as it is in the database (space, dash or slash).  If the query has too much information or it is 
not typed exactly the way it is in the database the answer pool will not find data.  If the UIC is known you should verify it.  
You can search by City or State or partial Unit name. 

If there, are any questions on what UIC to use; consult the Regional Audiologist or their representative for 
clarification. 

 Review with students how to search the UIC Locator database.  

UIC Locator is in the 
folder titled Audio 
Certification Class 

located on the desktop. 
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UIC LOCATOR PRACTICUM 

Find the DOD Component, UIC, City, State, Zip Code and Major Command for the following units.  You 
may have to adjust the wording/spelling to get the correct data.  These UICs will be used in following exercises. If 
there is FPO followed by 2 letters then the FPO will be the city and the following 2 letters will be the state followed by 
the zip code. 

1. USS John C Stennis CVN-74 Service: __________  

 UIC:__________ City:_______________ State:______ Zip Code:______ MACOM __________ 

 

2. VMM 764 MAG-41 4TH MAW; San Diego, CA  Service: __________  

 UIC:__________ City:_______________ State:______ Zip Code:______ MACOM __________ 

 

3. USCGC Jefferson Island   Service: __________  

 UIC:__________ City:_______________ State:______ Zip Code:______ MACOM __________ 

 

4. Fleet Readiness Center SE Det, Key West  Service: __________  

 UIC:__________ City:_______________ State:______ Zip Code:______ MACOM __________ 

 

5. K Co 3/8 2ND MARDIV, Camp Lejeune  Service: __________  

 UIC:__________ City:_______________ State:______ Zip Code:______ MACOM __________ 

 

6. USCG Station Portland OR  Service: __________ 

 UIC:__________ City:_______________ State:______ Zip Code:______ MACOM __________ 

 

7. 3/11, Twentynine Palms   Service: __________ 

 UIC:__________ City:_______________ State:______ Zip Code:______ MACOM __________ 

 

8. 293 MP CO, Fort Stewart, GA  Service: __________ 

 UIC:__________ City:_______________ State:______ Zip Code:______ 

 

9. 161 Engineer CO, ENGR SPT, Fort Bragg, NC  Service: __________ 

 UIC:__________ City:_______________ State:______ Zip Code:______ 
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UIC LOCATOR QUIZ 

1.  Describe the DOEHRS-HC UIC format for each service. 

 Army   ___________________________________ 

 Air Force  ___________________________________ 

 Coast Guard  ___________________________________ 

 Marine   ___________________________________ 

 Navy   ___________________________________ 

2.  What the “UIC” (WIC) is unknown by an Air Force Patient what UIC should they be tested under? 

 

3.  What is the “key field” driving most Service reports  

 

4.  What is the “weakest link” in having accurate reports?  
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DOEHRS-HC UIC DATABASE 

Class 15 minutes/Practicum 20 minutes 

Correctly enter each UIC (Unit Identification Code) into the DOEHRS-HC database.  Patients require their UIC to 
be entered and/or selected for their audiogram.  Most HCP reports draw from the patient UIC.  Marine and Navy personnel 
can be placed under either Service UIC.  Navy assigned to Marine Units, Marines assigned to Navy Units.  Army, Air Force 
and Coast Guard are placed under their own Service UIC.  Contact your Regional Audiologist (1st) or NMCPHC (2nd) for any 
questions you may have.  Displayed below is the UIC database from the patient demographic area in the Run Test screen.  
You can get to the UIC database several ways.  In the patient demographic window (Run Test Screen) right click on the UIC 
field and the UIC Edit window will appear. Edit>UIC and the UIC Edit window will appear. Function>Administrative 
Defaults.  Right Click on the UIC field and the UIC Edit window will appear 
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  Established “core” UICs in conjunction with the Regional Audiologist.  It will then be easy to maintain them.  Core 
UICs are UICs that belong to the units that repetitiously test at the testing site.  Unit Safety personnel work in conjunction 
with the HCPM to identify personnel and units exposed to hazardous noise.  A DR Inquiry (patient records pulled from the 
DR) will occur for every patient you test when connected to the internet.  This DR Inquiry may bring down the associated 
sub-tables along with each record imported.  Periodically go in and verify the test site “core” UICs. 

The UIC Database has the function to add new UICs (New), edit UICs in the database (Edit) and delete UICs not 
needed in the DOEHRS-HC database (Delete).  Ensure you press the correct button.  Notice the Test Installation UIC 
(68546) placed next to the Unit Name.  This is an easy way to monitor your UIC database.  Some Hearing Conservation 
Regions put the Regional Hospital UIC next to the Unit Name.  This lets the user know the UIC has been verified with the 
UIC Finder/Regional Audiologist and is one of the core UICs that need to remain in the local UIC database.  Below is the 
Patient Demographic window from the Run Test screen.  Displayed are some of the UICs in the DOEHRS-HC 
database.  UICs list numerically and alphabetically in the drop down window.  Note the Test Installation UIC (68546) 
placed next to the Unit Name in the UIC/WIC Edit window. Service Code at the end of the Unit Name in the drop 
down window. (A) = Army, (C) = Coast Guard, (F) = Air Force, (M) = Marines, (N) = Navy, (1) = Other 

        

Previous drop down window selections will affect subsequent drop down selections.  Example: if the DOD Comp 
selected is Navy or USMC only Major Commands from the selected service will be in the Major Command drop down 
window.  Army and Air Force Major Commands are not available for selection in the UIC database.  The UIC window 
displayed below with extended drop down windows.  ‘Other’ as a DOD component should not be chosen in the UIC 
database without the Regional Audiologist approval. 
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Use the UIC database to input the correct UIC and/or verify them with your Regional Audiologist or their 
representative.  Input the UIC for 3RD BN 11TH MAR (UIC Locator Practicum) 

Press “New” on the UIC/WIC Edit screen and input the data properly.  Create the UIC for L BTRY 3RD BN 
11TH MAR.  Enter the UIC M11330.  Do not put in command name L BTRY… An acronym the unit is locally called is 
recommended, encompassing the entire unit such as 3/11.  Address is not required. Enter city, state and zip code; major 
command if known should be entered.  When data entry is complete, press Save.  Once saved, the UIC will be available in 
the UIC drop down window for patient testing selection. 

   

You find the following UICs in your local database.  Write down if there are any problems 
with the UICs and what you would do as an Audio Technician. 

GROUP 1 

    

The above  2 UICs (GROUP 1)  are in the UIC database.  What is different between them?  
_________________________________________________________________________________________________ 

Are they both correct or is one or both of them incorrect?  __________________ 

Which one would be displayed first (normally selected more frequently) in the UIC drop down selection 
window for patient demographic data input?  ___________________ 

What would you do to fix the problem?  ______________________________________________________  
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GROUP 2 

    

The above  2 UICs (GROUP 2)  are in the UIC database.  What is different between them?  
_________________________________________________________________________________________________ 

Are they both correct or is one or both of them incorrect?  __________________ 

Which one would be displayed first (normally selected more frequently) in the UIC drop down selection 
window for patient demographic data input?  ___________________ 

What would you do to fix the problem?  ______________________________________________________ 

GROUP 3 

    

The above  2 UICs (GROUP 3)  are in the UIC database.  What is different between them?  
_________________________________________________________________________________________________ 

Are they both correct or is one or both of them incorrect?  __________________   

Which one would be displayed first (normally selected more frequently) in the UIC drop down selection 
window for patient demographic data input?  ___________________ 

What would you do to fix the problem?  ______________________________________________________ 
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GROUP 4 

    

The above  2 UICs (GROUP 4)  are in the UIC database.  What is different between them?  
_________________________________________________________________________________________________ 

Are they both correct or is one or both of them incorrect?  __________________ 

Which one would be displayed first (normally selected more frequently) in the UIC drop down selection 
window for patient demographic data input?  ___________________ 

What would you do to fix the problem?  ______________________________________________________ 

If you found one of the UICs incorrect then the technician who inputted it put the test installation (68546) next to the 
Unit Name, (verifying it).  Every patient tested under the incorrect UIC will guarantee inaccurate reports.  Ensure correct 
UICs are in the database.  Select the correct UIC for every patient.  Delete all incorrect and/or unnecessary UICs.  The 
following message will appear when delete of a specific UIC is pressed. When you press OK, the UIC will be deleted. 
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DOEHRS-HC UIC DATABASE PRACTICUM 

Create UICs in DOEHRS-HC for the below unit (came from UIC Finder Practicum page 25): 

1.  21847 USN USS John C Stennis CVN 74 FPO AP 96615
 AIRPAC   (Federal Post Office, Area Pacific) 

 

2. 03028S6E USMC VMM-764 MAG-41 San Diego, CA 92145  
 4TH MAW 

Note:  VMM-764 MAG-41 4TH MAW has 2 UICs: 03028S6E and 67824; USMC under their UIC, USN under their 
UIC. 

3. 0113440 USCG CGC JEFFERSON ISLAND South Portland ME 04106  
 D01 

 

4. 44320 USN Fleet Readiness Center (SE Det) Key West Key West, FL 33040  
 NAVAIRSYSCOM 

 

5. 12230V38 USMC  3/8 Camp Lejeune, NC 28542  
 2D MARDIV 

Note: Should be call 3/8 not K CO 3/8 

6. 1330486 USCG USCG STATION PORTLAND OR Portland, OR 97217  
 D13 

 

7. 113301NG USMC 3/11 Twentynine Palms, CA 92278  
 1ST MAR DIV 

 

8. WHGJAA USA 293 MP CO FT Stewart, GA 31314 

 

9. WATEAA  USA 161 Engineer CO, ENGR SPT FT Bragg, NC 28307 

 

Follow these instructions for each UIC entered: 

UIC entered.  DoD Component selected.  Unit Name entered with Command name or acronym.  Address 
and/or supplemental information entered.  City, State, Zip Code and Major Command (if known and field active) 
selected. 

Ensure all UICs are correct.  Edit those UICs that were entered incorrectly and /or incomplete.  
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PATIENT DEMOGRAPHIC DATA 

Class 20 minutes/Practicum 20 minutes 

Enter Patient Demographic Data in the Run Test screen when a patient is present for testing.  This data in 
conjunction with the threshold levels retrieved from the CCA-200 window will save as an audiogram (record).  Enter 
demographic data correctly and completely.  Incomplete data entry will restrict retrieving test data from the CCA-200 
window.  Have the patient fill out a demographic form (found in the DOEHRS-HC software).  This form will assist the 
technician inputting the patient data correctly.  Ensure the form has enough information so that patient data entry can be 
completed in DOEHRS-HC.  If more information is required, question the patient prior to placing them in the booth.  Write 
the information down on the Demographic Form.  In multi-station booths, recommend placing the station number on the 
same sheet.  Students (on your time) put your information on the demographic form.  It will be used later during 
patient testing. 

 

When a patient shows up for audio testing, enter their data into the run test screen, starting with the SSN.  The SSN 
is the PRIMARY KEY for each record created.  All manually entered DOEHRS-HC data can be edited at the original test 
location with the exception of the SSN.  Recommend getting the SSN directly from the medical record.  Data in the Run Test 
screen will be saved only when retrieving test results from the CCA-200 window.  
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For training purposes we are going to enter Demographic Data only without testing patients.  The Input 
Demographic Data window mimics the same fields in the Run Test Demographic Data section.  Unlike the Run Test 
screen data can be either editted or saved in the Input Demorgraphic Data screen.  This is just to get you used to 
entering patient data that can be saved without testing patients.  Go to Functions>Demographic Input. 

 

Enter patient demographics into the Input Demographic Data screen.  Note cursor when you open the Input 
Demographic Data window is in the last name field, move it to the SSN field.  Ensure you type in the SSN first, use the tab 
not the mouse and check each drop down window to get familiar with the data available.  Hot keys are available.  If you type 
in all the patient data and then find you have not typed in the SSN, as soon as you do all the information you just got done 
typing in will erase.    
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Do not use Service Comp “other” without the Regional Audiologist approval.  Enter civilian employees as 
Federal Employees or Contractors.  SDOC (Service Duty Occupational Code) is the MOS/NEC/NOBC.  If you know the 
patients’ job but not their Code right click on the SDOC window and bring up a list to scroll through until found/selected.  A 
spreadsheet of DOEHRS-HC (USMC, Navy) SDOCs is available.  Most Navy enlisted (NECs) and Marines (MOSs) have 
Conversion/Basic (transition positions). 

    

Previous drop down selections will limit future drop down data.  In the below figures data selected was Navy, 
Enlisted as you can see in the SDOC List by the Rates/NECs or NECs only may be displayed. 

    

If the UIC is not in the drop down window, right click in the UIC field to bring up the Edit UIC window and add the 
UIC. 
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Continue to fill out the patient data.  Location/place of work is the only field not standardized so you can free text 
information that can assist you locally.  Examples: Bldg 14, Engine Dept., Work Code, etc. Comm. Phone stands for 
Commercial Phone number; a phone number you can get in touch with the patient if needed.  Enter all data properly.  The 
same procedure of right clicking in a window will produce pop-up windows in most areas within DOEHRS-HC.  Have 
the students enter Zachary Clemons Demographic Data below: 

 

Once completed press save.  If any data is missing an error message will appear when you try to save it.  Similar 
error messages will appear if you try to retrieve test results from the CCA-200 software with incomplete patient data.  Data 
will be saved (retrieved in run test screen) if every required field is entered. 

       

Dependents (non-DoD employees) and children under 16 will not  be entered into DOEHRS-HC. Once a 
patient record is in your database, their data will surface when you type in their SSN.  You still need to verify and update 
patient information as needed.  

 

In the Run Test screen all fields remain inactive until you type in the SSN.  
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Enter data for patient Robert Jenkins.  This patient filled out his Demographic Data Form correctly except he 
didn’t know what his UIC was.  COMNAVSAFECEN is located in Norfolk, VA. Be familiar with the core UICs in the local  
testing database. 

 

 

Note: Changing the SSN doesn’t change the demographic data.  Press cancel to clear and then enter the SSN.  If the UIC is 
not in the dropdown window, right click to add the UIC.  To view SDOC – right click to bring up the full list. 
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PATIENT DEMOGRAPHIC DATA PRACTICUM 

Enter the following patients in the Input Demographic Data screen. 

 

 

Technicians need to be familiar with the core UICs, these UICs are in the local test site database.  Note: the Branch 
and Career Field had only one selection.  The major command should automatically load for USMC, USN and USCG if it is 
entered in the UIC database.  
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AUDIOGRAM TYPE 

Class 20 minutes 

This Chapter will review the Audiogram Type as seen below.  This covers HCP, Test Type, ENT, NFH, Noise 
Exposure, HPD and Eye Wear.  You will need to be familiar with the HCP in order to select the correct test type.   

Enter SSN 911020001 in the Run Test screen. 

 

Intial selection for Audiogram Type: Hazardous noise exposed (in the Hearing Conservation Program)? Yes/No.  The choice 
selection will limit your audio test type.  References, Annual, Follow-up 1 and 2 require “Yes”.  An error message will 
appear if a chosen test doesn’t coincide with the noise exposed selection.  Any other test selection will give you an Invalid 
Test Type error message.  Similar error messages may appear if the test type is invalid with previous data selections made.  
An example is trying to do a follow-up test on a patient that does not have an STS. 

       

Audiogram Type drop down selections are as follows: 

DOEHRS-HC has 5 different reference audiograms. The reference that the current 2216 test will compare against is 
the earliest reference audiogram in the patients’ history. The exceptions to this are type 3 and type 4 reference audiograms. A 
type 3 references is ear specific (can be one ear only) and re-established only after an STS is identified and confirmed. A type 
4 reference requires both ears to be tested and is used only when there is a change in service. Reference (DD 2215) if selected 
is the only test type that requires a reason for the test.  Reference audiograms require the patient to be 14 hours noise free. 

 
Type 0 Reference - This is a reference that is entered in the “Run Test” screen when a 2216 test is chosen and there is 

not a reference audiogram in the local database for that patient. These type 0 (manually Entered) references cannot be printed 
and are only associated with the 2216 test for comparison purposes only. 
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Type 1 Reference - Prior to Initial Duty in Hazardous Noise Areas. Test selected if the patient does not have a 

previous service related reference audiogram and the patient is less than 30 days noise exposed. 
 

Type 2 Reference - Following Exposure in Hazardous Noise Duties. Test selected if patient does not have a previous 
service related reference audiogram and the patient has 30 or more days of noise exposure. 

 
Type 3 Reference - Re-established After Follow-Up Program.  Re-established after follow-up program, future 2216 

hearing tests will compare against this reference audiogram (ear specific).  The DD 2215 may be re-established whenever a 
patient demonstrates the following: 

• Positive STS on a Follow-Up 2 test 
• Positive STS on Follow-Up 1 test, without a Follow-Up 2 test, and it is 30/60/90 days (depending on DoD/Service 

Component) beyond the periodic. 
• Positive STS on periodic test, without a Follow-Up 1 test, and it is 30/60/90 days (depending on DoD/Service 

Component) beyond the periodic. 
• Negative STS confirmed on a follow-up test. 

Type 4 Reference - Change in Service Component. (display a 4* in box 15 with an additional *explanation regarding 
the type 4 in the remarks section)  Test selected if the patient has a previous service related reference audiogram in 
DOEHRSHC-DR and the patient has changed services. Do not use this reference reason if there are not any references in the 
DR under the patients’ prior service.  Future 2216 hearing tests will compare against this reference audiogram. Use of this 
reference reason because the patient has a previous reference audiogram in the DOEHRSHC-DR AND there is a “definitive” 
change in service: 
 

• Former military personnel (Service Component = Regular, Reserve, or National Guard) change to civilian personnel 
(Service Component = Federal Employee, Contractor, or Foreign National). 

• Former civilian personnel (Service Component = Federal Employee, Contractor, or Foreign National) change to 
military personnel (Service Component = Regular, Reserve, or National Guard).  
 
Pre-Deployment; Post-Deployment; 90-Day; Annual; Termination; Follow-up 1; Follow-up 2 and “Other” are tests 

that are recorded on DD Form 2216.  FU 1/FU 2 (positive STS) are the only 2216 tests that require the patient to be 14 hrs 
noise free.  All DD Form 2216 tests compare the current test to a Reference audiogram.  If the reference is not displayed in 
the Run Test screen it will need to be added when the test type is selected.  The following pop-up window will appear.  
Ensure you get the data from a DD Form 2215.  Change the test type if a DD Form 2215 is not available and the DR 
Inquiry did not bring back a reference audiogram.  Note: For 2216 tests (not follow-up testing) it is recommended patients 
come directly from noise, if there are no STS then they are probably wearing their HPDs properly. 

 

If the DD Form 2215 is available, enter the data (threshold levels and date of test) in the Run Test screen. 

 

To make corrections for data entered in error; complete the data entry in the current field then press Shift/TAB, go 
back and make corrections.  Enter the following reference threshold data for 911020001 in the run test screen. 
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Press Save when data entry is complete. 

 

The record is displayed (DOEHRS-HC) as a Manually Entered Reference Audiogram (type 0).  Note: This 
record cannot be printed. 
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Ear selection field on certain tests (annual as an example) is not activated, when it is active, it will default to specific 
ear(s) (follow-up testing) depending on the periodic test STS results and DoD/Service Component.   

       

Changing the default may result in error messages appearing. 

 

 

Sections for ENT issue are Yes, No or Unknown.  The patient is present, ask them.  Unknown should be rarely used.  

What type of hearing loss would lead you to suspect ENT issues?  ________________________________________ 

Enter Noise Free Hours (NFH) in conjunction with the test type chosen.  If these choices are incompatible, an error 
message will appear.   

 

TWA-dBA and dBP exposure are located on the IH survey.  If unknown, do not enter any data in these fields.   

HPD question will display HPD (2215) Issued or HPD (2216) Worn depending on the test type.  Select yes and the 
HPD Selection screen will appear.  If a patient states they do not wear HCP and they are in the HCP recommend an electronic 
remark in additional to selecting no.  Initial Primary HPD choice selection will limit the Secondary HPD selection to 
compatible HPD types.  Choosing Ear Canal Caps will limit the selection to only Primary Hearing Protection Devices. 
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Choosing Noise Muffs will limit the Secondary HPD selection to Ear Plugs and Other.  Selecting Ear Plugs will 
activate a drop down selection.  Ear plug size will appear when selecting Single or Triple Flange earplugs.  Once the selection 
is completed Double Protection Yes/No will need to be answered and further selections made.  Choosing Helmets will 
activate a drop down selection.  Choosing Other will bring up a “free text” window where the Hearing Protection Device can 
be manually entered.  Once the selection is completed Double Protection Yes/No will need to be answered and further 
selections made.  Glasses/Goggles Worn (Always, Seldom, N/A) is required to be entered as these may interfere with the 
HPD worn.  Press OK when HPD selection is complete.   

       

 



43 

AUDIOGRAM TYPE QUIZ 

1.  How many audiograms (tests) can be recorded on a DD Form 2216? 

 

 

2.  A USN military service member comes in for audio testing.  A DD Form 2215 is not in their medical record and a DR 
Inquire does not bring back any reference audiograms.  The service member is not in a Hearing Conservation Program.  What 
type of test and/or reason is required for this patient? 

 

 

3.  What type of earplugs also requires size selection in DOEHRS-HC? 

 

 

4.  What would you do if you do not see the patient hearing protection device in any of the HPD drop down windows? 

 

 

5.  A civilian patient shows up for audio testing.  They are required to have an audiogram completed because of their job.  
They are not in the Hearing Conservation Program and do not have a DD Form 2215 in their medical record.  A DR Inquire 
did not bring back any references.  What type of test and/or reason is required for this patient? 

 

 

6.  How many Noise-Free hours are required for an annual test? 

 

7.  When would a type 4 reference audiogram be used? 
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MANUALLY ENTERED REFERENCE AUDIOGRAM (Newly Created) 

Class 10 minutes/Practicum 35 minutes 

This chapter will put all the information you have previously learned into practice by manually entering an 
audiogram.  There are 2 ways to manually enter (create) an audiogram; from scratch or from a previous record.  Entering data 
from scratch may require inputting the following information: Patient UIC; Test Site Installation; Audiogram Test 
Type/Reason; New Examiner and Audiometer.  Example: Test conducted by an Audiologist and entered by a technician. 

This lesson will ensure you understand how the data entry in the sub-tables and fields interrelates with the various 
forms.  Data integrity is very important.  Audiologists conduct an Audiologic Evaluation and record results on the below 
form or one similar to it.  Highlighted areas are the ones you need to use to entered evaluation as a reference audiogram. 
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All data required to input the test is not located completely on the Audiologic Evaluation form.  When at your test 
site, get the required information prior to attempting to enter the audiogram into DOEHRS-HC.  We will provide you with all 
the data required to enter the Audiology Evaluation conducted by an Audiologist for patient Jose Houston.   

Re-establish the following audiogram performed by an Audiologist.  ONCE YOU HAVE ENTERED THE 
AUDIOGRAM INTO DOEHRS-HC, PROCEED AND CHECK YOUR DATA ENTRIES. Highlighted areas display 
data required in order to input the reference audiogram. 
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The symbols on the audiogram (graph) description are located in the Legend.  These are the threshold levels that 
need to be entered into DOEHRS-HC.  Recommend writing them down and then entering them into DOEHRS-HC.  Ensure 
the frequencies/threshold levels are entered correctly, 500Hz, 1000Hz, 2000Hz, 3000Hz, 4000Hz and 6000Hz.  The 
evaluation shown has threshold levels for 250Hz thru 8000Hz.  Write down the thresholds levels prior to inputting them into 
DOEHRS-HC. 

_____   _____   _____   _____   _____  _____          _____   _____   _____   _____   _____   _____ 

 

      

These sections have the patient data, Audiologist information, Audiometer information, Patient Data, Date and time 
of the test, required to re-establish baseline.  

       

Additional information is required to enter the Audiologist:  SSN = 912140002, works in Audiology, Navy, 
Civilian employee, GS13, Speech Pathology & Audiology (Change to Order of Description), Testing booth is located at 
NMCPHC (68546), Portsmouth, VA.  Complete Patient data is on the DOEHRS-HC Patient Demographic Data Form.  

Add an electronic remark inputted or entered into DOEHRS-HC by _________.  
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To enter an audiogram into DOEHRS-HC go to Functions>Input Audiogram>Select test type.  Select ear(s) to 
be inputted. What test type/reason are you about to enter?_______________________________   

 

Do not go past this page until the audiogram is completely entered and saved. 
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CHECK AND CORRECT ANY MISTAKES, USE EDIT AUDIOGRAM WINDOW. 

To re-establish the reference bilaterally you should have chosen DD Form 2215 both ears.  Be careful not to press 
‘enter’ after the SSN is entered as pop-up screens may appear/disappear without visibility due to pressing enter to quick.   

If an STS was present on the latest follow-up last (within prescribed service limits) or on an annual (exceeding 
prescribed service limits, unresolved STS) a re-established DD2215 window will appear asking if you would like to re-
reference the reference using a previous test.  We will review this process in the next chapter. 

 If a previous reference is present in the local database, a ‘Reference Exists’ window will appear  telling of the 
reference history and ask do you want to enter a new reference audiogram.  Press yes. Below are examples of the screen you 
will see.    

    

Enter DD 2215 Reference window will appear. Ensure you type in the patient SSN first.  Type or verify patient 
Demographic data, SDOC – find by right click in field, UIC is 40442.  Enter date/time of test, select test reason.  Ensure you 
check both ears for correct dates.  If only one ear is selected to be re-established, the other ear will not be active for data 
entry.  Enter threshold levels for the audiogram.  Write the threshold values down prior to entering them into DOEHRS-HC.  
Ensure you transfer the data correctly, 500Hz/40dB, 1000Hz/45dB etc.  Any non-numeric thresholds are entered in 
UPPERCASE.  All future periodic test results will compare to this reference audiogram (ear specific).  If the examiner 
(audiologist) is not in the drop down window, right click in the examiner field to bring up the examiner data window. 
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Expanded SDOC List.  Examiner Data window appears; enter audiologist information.  Ensure ‘Currently Active’ is 
checked.  Order of Occupation Description lists drop down alphabetically.  Order of Occupation Code lists drop down 
numerically.  Make sure you enter the correct testing facility, this may not be your testing facility but is where this examiner 
is testing patients.  Once complete, press save.  Examiner will also be available for future selection. 

    

 

‘Audiometer SN’, the audiometer that was used to conduct this test is entered here.  If the audiometer/calibration 
date is not in the drop down window, you need to right click on the Audiometer SN field and the Add Audiometer window 
will appear.  Add the audiometer.  Is all the information correct?   

The defaulted information is geared toward CCA-200m not the manual audiometers the audiologist use.  Pay 
attention the date defaults to the present date; put in the correct date of calibration, change the audiometer type to 
Manual. 
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Noise Free hours for references need to be at least 14 hrs.  ENT Problems?  An audiologist will not re-establish a 
reference audiogram on a patient with temporary conductive issues.  The HPD selection window will appear when yes is 
selected in HPD issued window.  Primary and Secondary hearing protection device selected. Glasses worn? 

 

Enter remark by pressing the ‘Add Remark’ button.  Example:  Inputted or entered into DOEHRS-HC by 
_________.  Once entered it will be in the drop down window for future selection. 
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Completed audiogram, check all data entry prior to saving. 

 

Once Save is pressed, a Question window will appear.  Answer the questions.  Was Health Education (counseling) 
provided?  Does the Patient experience Tinnitus? 

 

Once saved, print the 2215.  A referral may be generated.  Referrals generate from the threshold levels of the 
audiogram and/or test type.   

Entering a DD 2216 is the same except you need to enter the reference audiogram, (needs to be retrieved from the 
DR or manually entered from the medical record). 

If the patient is not in the database, enter all data.  If the patient is in the database, verify that all information is 
correct as you tab through the different fields. 

Note: never manually input an audiogram with the same date and time of a patients record in their DOEHRS history.  
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MANUALLY ENTERED REFERENCE AUDIOGRAM (Newly Created) QUIZ 

1.  How often are audiometers added to the DOEHRS-HC database? 

2.  How often is an Examiner added to the DOEHRS-HC database? 

3.  What type of audiometer does the Audiologist normally use? 

4.  Name the 4 types of Reference audiograms that can be printed and explain when you would conduct them: 

 

 

5.  What test(s) require a reference audiogram? 
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MANUALLY ENTERED REFERENCE AUDIOGRAM (Previous Test) 

Class 5 minutes/Practicum 5 minutes 

Input a 2215 from a previous test.  There could be a negative or positive shift. 

The software will automatically re-establish the baselines for a negative shift.  Immediate retest, follow-up needs to 
occur after retrieval of the periodic test.  When the Follow-up 1 test is retrieved into DOEHRS-HC the baseline will 
immediately be re-established.  Pressing the print button in the run test screen will only print the DD Form 2216; you will 
need to go to audiogram edit or summary in order to print the reference. 

Consult your Regional Audiologist on the process for positive shifts and re-establishing baselines.  There should be 
a Standard Operating Procedure (SOP) established that will state the technicians’ authorization in regards to re-establishing 
baselines.  If not in the SOP you should not re-establish any references except negative shifts. 

Testing Patient:  When retrieving test data from the CCA-200 window (follow-up 2) the software will ask if you 
want to create a re-established baseline.  Your response depends on the authority the Regional Audiologist gave to the audio 
technician in the local SOP.  Do not re-establish baselines if you are not authorized to do so.  If in doubt, do not re-establish 
the baseline, press no, and forward the referral and appropriate information to your Regional Audiologist.  If you 
have the authority to re-establish the baseline press yes ensuring you add a remark on the 2215 on why it was re-established.  
Remember, you will need to go to audiogram edit or summary to print the DD Form 2215. 

     

 

Above screen is asking if a previous test will be used as the re-established baseline.  Select “yes” and the testing 
series will appear.  Select the most appropriate audiogram as the baseline. 

   

Baseline is re-established.  This process is very easy/quick and the possibility of erroneously re-establishing a 
baseline is great.  Ensure you have the authority to re-establish the baseline. 

 Have student go to edit audiogram, type in SSN: 912010066; view the final product of an audiogram that was re-
established using a previous audiogram.  Review patient audio history/remarks. 
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Patient Referral:  Follow-up testing series has finished Richard Tuttle, 912010062.  The audiogram/referral 
processed through proper channels.  
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Referral with disposition instructions was found in the medical record. Baseline was never re-established in 
DOEHRS.  Re-establish baseline IAW the SF 600. 
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Once done, print the form. 
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CCA-200 (Patient Testing) 

Class 20 minutes/Practicum 20 minutes 

Prepare your equipment for patient testing.  Conduct Functional Check/Daily Calibrations prior to class.  This is 
normally done only once a day.  We will review both the automatic and manual testing in this chapter.  Ensure the booth 
number(s) in DOEHRS-HC are bold and the CCA-200 is available (working) for patient testing. 

 

Prepare the patient for testing.  Collect Patients Demographic Data Sheet.  Collect Patients Medical Record.  
Perform Otoscopic Examination (if needed).  Explain what to expect during testing.  Give the patient clear pre-test 
instructions:  remove glasses, chewing gum/tobacco, barrettes, earrings, hearing aids; turn off pagers/cell phones and 
explain the software will give automatic start/error instructions.  These instructions are presented to the patient prior 
to putting on the headphones. 

Special testing situations: test the better ear first; unilateral hearing losses may require intervention by audiologist; 
claustrophobic patients; patients with tinnitus or extreme hearing loss; collapsing ear canals.  Do not test draining ears, 
external otitis. 

Ensure the patient is at the correct testing station.  Write station number on the demographic sheet.  Headphones on 
properly, red on right, diaphragm centered over ear canal, headband on top of patients head, snug fit without squeezing.  
Patient has response switch in-hand. 

Close the booth door, start patient testing in the CCA-200 software.  Have the patients test while you input/verify 
their data in DOEHRS-HC.  There are various ways to start, stop, clear and conduct manual testing (menu, hot keys, Icon and 
right clicking on test line). 
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Patient testing starts with instructions: “This is a hearing check.  You will be listening for some tones.  When you 
hear a tone, press the button once and quickly release the button.  No matter how faint the tone, press the button when you 
hear the tone and quickly release the button.  Upon completion of your hearing check, please remain seated and quiet until the 
operator releases you.”  Adjust message volume to an acceptable level prior to testing patients. 

    

Audio Testing starts on the left ear at 1000Hz (confirmation test).  Social Security Number is not in the CCA-200 
window (ID Number) because patient data transfer has not occurred from the Run Test window yet. 

 

Audio testing can begin first on the right ear by checking Other Ear First prior to starting the test.  This is a viable 
option when one ear only needs to be tested during the follow-up testing sequence.  Note if only one ear required testing you 
can retrieve their data as soon as that ear is complete even if the other ear is not finished.  You could do 2 follow-up tests on a 
single ear in the same time test on other patients (both ears) are accomplished. 
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Above test started on the right ear.  Input and/or verify patient data off of the Patient Demographic Data 
Form/Medical Record while patients are being tested and monitor the testing. 

Thresholds levels “lock in” when a patient responds to same dB level twice in an ascending manner.  Testing length 
depends on the patient; some finish faster than others.  The graph mirrors testing and locks in the dB level after the patient 
responds twice to the tone in an ascending manner.  Note: Patient data has not been transferred from the Run Test 
screen to the CCA-200 window. 

 

 

Error Codes are as follows: NR/No Response, NT/Not Tested, MR/Multiple Response, SE/Subject Error, 
CR/Continuous Response, RN/Retest Not Valid, PT/Presentation Timeout.   
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Frequencies may highlight automatically and when the final frequency on the initial testing has been completed, the 
software will retest highlighted frequencies.  You can also manually create and/or remove the retest (highlight) by left 
clicking on it. 

Automatic re-test:  Depending on the test configuration, invalid thresholds (error codes), thresholds >90dB, 
thresholds at 500 Hz >30dB, adjacent frequencies differ by >50dB, thresholds between ears differ (same frequency) by 
>40dB, thresholds are +/-15dB from reference and/or thresholds +/-10dB from reference at 2000 Hz, 3000 Hz or 4000 Hz. 

 

Manually retest frequencies when Cross Hearing is suspected, questionable results, patient is having 
problems testing or results differ greatly from the last test. 

Manual Test Technique:  Select the frequency and ear you want to test.  Start at 0dB.  Conduct a sweep at 20 dB 
until the patient responds.  Present stimulus (tones).  Bracketing method is used, dB level will increase by 5dB (no patient 
response) decrease by 10dB (patient responds).  Pulsed tone presentation (3 tones).  Vary stimulus interval to counter 
patient guessing.  Verify patient response by presenting the same Hz/dB level of the initial patient response.  Continue 
Bracketing Method of down 10dB and up 5dB (semi-automatic) until the patient responds at the same decibel level 2 out of 3 
times in an ascending fashion.  Recorded threshold level will appear when ‘locked-in’.  Work quickly but carefully.  Ensure 
the patient cannot observe your presentation of tones.  Below patient is having some issues, we will manually test the 
3000 Hz right ear. 

  

There are several ways to bring up the Manual Test Booth window.  Previously we right clicked anywhere along the 
booth test row. 
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You can also bring up the Manual Booth Test window (single station booth only), by using the drop down from 
audiometer hot key F9 or click on the Icon in the tool bar. 

 

Manual Test screen appears.  Threshold levels will be present if they are locked in from the automatic test.  
Software automatically defaults to Left ear, 1000Hz, 30dB; ensure you change to the frequency/ear you want to test.  Start 
testing frequency at 0dB. 

 

Change the frequency to 3000, select Right Ear, and change the dB level to 0 and Set NT (Not Tested), so you are 
aware when a threshold level locks in.  Threshold level will lock in automatically when patient responds twice in an 
ascending manner.  Present Stimulus to patient, dB level will increase/decrease depending on the patient response. 
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 Patient responding to the tones being presented. 

 

Threshold level locked in, ensure you press ‘OK’ not cancel or the manual threshold result will not transfer 
to the patient test. 

 

Have the students practice doing Manual Testing locking in threshold levels and having class proctors review 
their process. 
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Test is finished.  Notice the 3000Hz decibel level is displayed as 5m (manually tested) this will only appear in the 
CCA-200 window.  The “m” will not be displayed in the run test screen or on the printed test. 

  

Once patient data is transferred from DOEHRS-HC to the CCA-200 software you can physically see the reference 
threshold levels in comparison to the current test on the audio graph.  Assess test results and mentally prepare patient 
counseling (threshold levels, STS, etc) for additional testing and counseling preparation. 

Software may be set up to “Keep Busy” when the patient test is complete.  Tone presentation continues and the 
patient responds to them; these responses are not recorded as the patient test is completed.  This option is normally used in 
multi-station booths to keep patients busy until all tests are complete. 

Here is a brief overview of what should occur. 

1. Receive Medical Record and Demographic Data Form 
2. Review forms, question the patient if you need additional information 
3. Write booth number on Demographic Form, place patient in booth (correct location) 
4. Give patients pre-test instructions 
5. Ensure patient have the headphones on properly and have the response switch in hand 
6. Close booth door 
7. Start patient tests 
8. Input patient data and select test type,  keeping an eye on the testing that is occurring in the CCA-200 

window 
9. Transfer patient data from the Run Test window to the CCA-200 window 
10. Review patient tests and mentally prepare counseling thoughts 
11. Retrieve data from the CCA-200 window into the Run Test window, paying attention to any pop-up 

messages that appear 
12. Answer applicable pop-up window questions 
13. Print test(s) and counsel patient(s) 
14. Provide Follow-up testing, process referrals appropriately 
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CCA-200 (Patient Testing) QUIZ 

1.  In regards to Audio Testing, when would an Otoscopic Examination be performed? 

 

2.  What would you do if you notice a patient continuously pressing and holding the headphones against their ears during 
testing? 

 

3.  When would you manually test a specific frequency? 

 

4.  What instructions does a patient need prior to placing the headphones on? 

 

5.  Explain the “Bracketing” technique. 

 

6.  What should the technician do while the patient is testing? 

 

7.  What does the error code NR, NT and MR stand for? 

 

8.  Why do you review the test data prior to retrieving it into Run Test window? 
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DOEHRS-HC Run Test & CCA-200 (Patient Testing) 

Class 30 minutes/Practicum 90 minutes 

In this chapter, we will enter/verify patient data in the Run Test screen, select the correct test type, transfer patient 
data, review threshold levels prior to retrieval, retrieve data, counsel and provide follow-up testing as needed. 

This lesson assumes the DOEHRS-HC software is open without any hardware error messages, Functional and Daily 
Biological Calibration Checks have been accomplished and were successful. 

Place the Run Test and the CCA-200 screens side by side or overlapping to observe both screens/assist in switching 
back and forth between screens.  Monitor patient testing while inputting and/or update patient data entry in the Run Test 
window. Bring up the UIC Finder software/DMDC spreadsheet to use during patient data input (if needed). 

 

Receive demographic sheet from the patient and verify you have sufficient data to input the patient.  You would give 
the patient instructions, have them place the headphones on (verify they are on correctly), close booth door and start the test 
in the CCA-200 window.  Enter patient’s SSN into the Run Test Screen, enter/update patient demographics, and select test 
type and HPD.  Monitor test progress in CCA-200 window while entering data. 

Use the BAS to simulate a patient.  Start a patient test in the CCA-200 window.  Monitor the test progress 
while you enter your patient data in the Run Test screen (use your own data as the patient data).  Select a non-hearing 
conservation test as the test type.  Once your patient data is completely entered, transfer the data from the run test 
screen to the CCA-200 screen.  ALWAYS PRIOR TO RETRIEVING THRESHOLD DATA from the CCA-200 
window, review the results and mentally prepare to counsel the patient, also if inaccurate results are suspected 
conduct a manual/automatic retest.  Once the test is complete, retrieve results, you would then normally print the 
audio test and counsel the patient.   

A patient appears at your test site and hands you the following Demographic Data Form and their Medical Record.  
Patient works at Fleet Readiness Center SE Key West and does not know what the UIC is (which is OK as this is one of the 
“core” UICs and is in your database).  The Patient also states he works in BLDG 14.  Use the BAS to simulate a patient.  
Start the test (BAS) and while testing is occurring, enter patient data in the run test screen.  Need to enter data 
completely starting with the SSN.  Check to ensure data entry is correct. 
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Reviewing the patient’s Medical Record (Deloach) you locate the most recent 2215 it is a [type 3 (L/R)] which 
has the following testing results.  Normally if connected to the internet and a DR Inquiry was conducted this information 
would have downloaded into the database. 

 

Perform the test completely.  Transfer, retrieve and print test prior to continuing with this chapter.  Once 
complete move on and check your work. 

Once the SSN is entered in the Run Test screen, the software will automatically do a DR inquire if the computer and 
the DOEHRS-HC Application is connected to the internet.  If the DOEHRS-DR account information is not entered the Login 
screen will appear.  This screen is associated with the examiner who is logged into DOEHRS-HC.  A DOEHRS DR account 
is required to conduct audio testing. 
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If the DR Inquiry brings back patient data; ensure you check it and make updates/corrections as needed.  Use the 
Tab key to move from one field to the next to ensure all appropriate data has been entered.  Patient testing may finish prior to 
all patient data being entered.  This may happen when you first start testing.  Speed will come with experience. 

Correct data needs to be entered.  If you make a mistake, complete the field you are currently in and then ‘Shift/Tab’ 
back to the mistake and enter the correct data. 

If a DD 2216 test is selected and the reference is not present in the database, the User is prompted to enter the 
reference thresholds and test date.  This information if not pulled from the DR needs to come from the patient’s medical 
record.  Ensure when you check the medical record; review briefly the 2216’s and 2215’s.  Ensure the reference you are 
entering is the correct one (latest 2215 and not the reference from a 2216).  Manually entered reference (Type 0) thresholds 
do not provide enough information to produce a complete DD 2215 test but are adequate for completing a DD 2216 Hearing 
Test.  Prior to pressing save ensure all threshold data is correctly entered. 

   

    

Finish filling out the test data.  ENT problems, NFHs, if the patient’s noise-exposure levels are known enter them, 
otherwise, leave them blank.  HPD used, Yes.  

Note: if HPD are auto loaded, you can verify the data without entering the HPD window. 

Patient data has not been transferred from DOEHRS. You will notice reference audiogram was entered but not 
saved.  Once saved, transfer data. 
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HPD Selection window appears.  Select HPD used and size (if applicable), Double Protection if used and type, 
glasses or goggles worn. Completed data entry (confirmed patient data is correct). 

 

Transfer patient data to the CCA 200 window.  Prior to retrieving data into the run test screen review test results and 
mentally prepare patient counseling (threshold levels, STS, etc).  Does the patient have a change in hearing (STS), which ear, 
will they need to return for follow-up testing, do they need to return and be noise free, etc? 
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Retrieve test data into the Run Test window.  Health questions appear automatically.  Health education provided 
equals patient counseling.  Checked boxes in the Question window reflect yes. 

 

Several pop-up windows may occur.  Station was successfully saved.  Positive STS, software automatically checks 
for referrals/creates reports: positive/negative STS, OSHA reportable hearing loss, early warning shift, masking required, 
asymmetrical hearing loss, etc.  Press OK, Record has been saved. 

    

 Print test. Counsel Patient and have the patient sign in the remarks. 
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Printed Audiogram, counsel patient, patient is required to sign DD Form 2216.  Inform the patient that they need to 
be noise free (HPDs don’t count) for at least 14 hours prior to returning for follow-up testing.  

 

Ensure patient data is cleared from both the Run Test and the CCA-200 screens prior to testing another patient.  
Cleared patient data from the CCA-200 and Run Test windows.  We are prepared for the next patient. 

 

Testing Procedure Summary: 

1. Receive Medical Record and Demographic Data Form 
2. Review forms, question the patient if you need additional information 
3. Write booth number on Demographic Form, place patient in booth (correct location) 
4. Give patients pre-test instructions 
5. Ensure patient have the headphones on properly and have the response switch in hand 
6. Close booth door 
7. Start patient tests 
8. Input patient data and select test type,  keeping an eye on the testing that is occurring in the CCA-200 

window 
9. Transfer patient data from the Run Test window to the CCA-200 window 
10. Review patient tests and mentally prepare counseling thoughts 
11. Retrieve data from the CCA-200 window into the Run Test window, paying attention to any pop-up messages 

that appear 
12. Answer applicable pop-up window questions 
13. Print test(s) and counsel patient(s) 
14. Provide Follow-up testing, process referrals appropriately  
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DOEHRS-HC Run Test & CCA-200 (Patient Testing) PRACTICUM 

Test Blake Owens (use BAS).  Decide what type test you will conduct. Manually test 4000Hz right ear.  Prior 
to clearing test results in the CCA-200 software have a proctor review the manual test.  Start the test in the CCA-200 
software. 
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Test Tangerine Long (use BAS).  She got out of the USCG and last week gained employment as a USCG civilian 
employee in the motor pool and is frequently around hazardous noise, she wears earmuffs in the maintenance area.  She 
needs a hearing test for her job.  Manually test 3000Hz left ear.  Prior to clearing test results in the CCA-200 software 
have a proctor review the manual test.  Start the test in the CCA-200 software. 
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Prior to this exercise.  Print student audiogram so they can review them for errors and possibly have a 2215 
available for this exercise.  Also have each student fill out a DOEHRS-HC Demographic Form with their own 
information.  Every student is in the Hearing Conservation Program and exposed to hazardous noise.  Conduct tests 
as appropriate.  Issue one of the below references to at least one student to be used with their 2216 (use both 
references).  Reference dates may require change depending on the age of the patient (17/18).   

Instructors:  Identify an initial examiner and a patient. 

Patients: give your demographic form to the examiner. 

Examiners: Review demographic form and ask any questions in regards to data entry.  Give pre-instructions 
to patient.  Have the patient place the headphones on start the test while inputting patient data.  When the test is 
finished, review it for accuracy/possible frequency retest.  What do you do now?  Prepare thoughts for counseling.
 Do not retrieve results into the run test screen.  Stop testing; have patient remove headphones; switch 
characters 

Counseling will be done when classroom testing is stopped and after both characters (examiner and patient) 
have been performed by each student. Retrieval of data will be done individually along with a dialogue from the 
examiner on what they would do depending on the results.   

Date of Reference if patient is underage using the below reference dates _______________. 

REFERENCE #1 

 

 REFERENCE #2 

 

Time allowing, have a few students test each other with hearing protection in their left or right ear 
and manually test 4000 frequency in the ear that doesn’t have the HPD in.  With large classes this exercise 
may be restricted to demonstrate different test results. 
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ADMINISTRATIVE DEFAULT 

Class 5 minutes/Practicum 5 minutes 

The Administrative Defaults pre-fills out patient data in the Run Test screen (only if the patient is not in your 
database).  If you are testing at a clinic that has patients from multiple units an administrative default is of little use.  It works 
well with test locations that are not connected to the network and test one unit at a time.  An example of this would be a test 
site located on a ship or a MOHCAT going to test an individual unit.  Administrative defaults are for the patient not the 
testing location and should be created only for Units that have heavy Audio testing workloads. 

One Default is required in order to close the Administrative Default window.  This window will automatically pop 
up if you are creating a new database.  Press “New” and enter the name of the unit you are creating the default for.  Once a 
default is saved it cannot be deleted.  Unlimited defaults can be created.  Create defaults only for in mass patient data entry.  
Change patients demographic information in the run test window as needed. 

Go to Function > Administrative Defaults 

 

Administrative defaults are for group specific demographic data.   

Follow along with the Administrative Default for the USS John C Stennis.  If creating a new Administrative 
Default Press New.  The name is used to identify the organization you are creating the default for.  Select the Unit 
DOD Component.  Do not create an “other” DOD component default.  Select the UIC.  If the UIC is not in the drop down 
window or you cannot see the expanded description, right click on the UIC field and the UIC/WIC Edit screen will appear.  
Create and save UIC.  Select the Major Command.  You can use the space bar to bypass Location/Place of Work.  Phone 
number is a required field; enter 757-555-5555. Ensure you put in a correct phone number in the Run Test screen when 
testing patients.  Add the Hearing Conservation Program Mangers Office Symbol (where they work) their name and 
title.  Medical, HM1 Jonathon Smith, PMT.  

 

When you create an Administrative Default, ensure you save it.  Have the students type the SSN 123123123 in the 
run test screen to demonstrate what the administrative default does when inputting the patient SSN and there in no 
data for that patient in the database.  Note: The DOD Comp, UIC, Major Command, Location and Commercial 
Phone are pre-filled in from the administrative default.  Have Class proctors check work. 
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DOEHRS-HC (Database Backup) 

Class 5 minutes/Practicum 5 minutes 

DOEHRS-HC has a manual back-up procedure.  Daily database backups provide a fail-safe for data corruption not 
hardware failure.  Be aware that the database can become corrupt if the back-up process is stopped (power turned off).  
DOEHRS-HC backups are an exact copy of the entire DOEHRS-HC database (at the date/time Backup is created). 

Manual Backup: Backup process is initiated by the user.  Manual Backups are saved to the C Drive>DOEHRS-
HC>Backup folder (defaulted location) another location can be chosen.  To initiate the Backup process within DOEHRS-HC 
go to Data>Backup Database.  Files are automatically named: DOEHRS-HC_Backup_YYYYMMDD_TIME.ZIP.  The 
only portion of the name that changes is the date and time.  Do not change the file name.  There is only a need to save the 
past three Manual Backups, delete previous ones. 

    

The following message will tell you the Backup was successful.  It will also tell you where the file is and what it 
was named. Back Up Folder short cut is located on the desk top 

      

 

You could change the Backup location to a shared drive.  Every Backup tells you to copy the Backup to an external 
device.  It does no good to have all your Backups on the C Drive and have the C Drive crash.  Do not routinely create a new 
database as you can only edit records that have been created on your database. 

DOEHRS-HC (Database Backup) PRACTICUM 

Conduct a manual Backup and bring up the Backup Folder.  Have Class proctors check work.  
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DOEHRS-HC (Patient Data Functions) 

Class 5 minutes/Practicum 5 minutes 

There are many ways to search for Patients in the DOEHRS-HC database.  It all depends on what your desired 
outcome is.  Edit Audiogram:  Go to Edit>Audiogram.  Only audiograms that have been created on the testing database 
can be changed.  Data cannot be changed that has been imported from the DR or threshold levels retrieved from the CCA-200 
software. 

     

Press Advance Search. Patient Search window appears, Queries can be accomplished by SSN, Last/First name 
(Partial name is OK) or test type.  If nothing is selected, all patients will appear in the dropdown window.  All search features 
within DOEHRS-HC are the same. 
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Once a patient is selected, all data pertaining to them will be displayed in the Audiogram Edit/Delete window.  Edit 
tests as needed.  Only tests created on this database can be changed.  Do not delete a record that has been exported to the DR.  
If it is deleted from the original database, changes cannot be made without going through the DOEHRS-HC help desk.  Select 
the test and then press Edit.  You can also print from this screen. 

  

You can print from any screen displaying patient records.  Audiometry Summary and Forms allow you to 
view/print records.  Records cannot be changed in these locations. 

 

 

  



82 

DOEHRS-HC DR ACCOUNT REQUEST 

Class 10 minutes 

Every Audio Technician is required to have a DOEHRS-HC Data Repository (DR) account.  Apply immediately 
when you become a certified technician.  Account is needed to do updates to the DOEHRS-HC and export/import 
audiograms to/from the DOEHRS-HC DR.  Import patient data occurs with every patient tested in the Run Test screen 
automatically on an internet connected testing computer.  All patient data is required to be exported to the DOEHRS-HC DR.  
This includes non-internet connected testing computers.  Updates (all drop down windows in DOEHRS-HC) come out at the 
beginning of each month and need to be downloaded and installed to the local DOEHRS-HC computer.   

To apply for a DOEHRS-HC DR user account go to: 
https://doehrswww.apgea.army.mil/doehrsdr/pub/AccountRequest_input.action 

This is a CAC enabled website, YOU NEED TO USE YOUR OWN CAC CARD AS YOUR CERTIFICATES 
WILL BE ASSOCIATED WITH YOUR DR USER ACCOUNT.   Request Account.  You also have assistance for 
DOEHRS-HC DR locked-out, Forgot Password/Username. 

If you already have a DOEHRS-HC DR account contact your Regional Audiologist for assistance.  Choose HC for 
the functional group and select Service Branch.  Fields that have an * are required to be filled out completely. 

 

Pay particular attention that the User Identification is filled out correctly.  This information will be requested when 
you are locked out of DOEHRS-HC DR or when you change your password (every 60 days).  User name will be derived 
from your name.  Verification information required will be User Name, First Name, Last Name, SSN and Mother’s 
Maiden Name. 

 

 

 

 

User CAC is required to be in the computer when they apply for a DR user account. 

If they already have an account and it needs to be reactivated, seen Theodore Mason and email. 

 

https://doehrswww.apgea.army.mil/doehrsdr/pub/AccountRequest_input.action
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Fill out each field.  All DOEHRS-HC DR automated emails will go to the email address associated with your DR 
account such as Successful Uploads, DR temporary passwords, etc.  A DOD (.mil) email address is required.  Civilian 
email addresses will not be approved.  Email returned (email address unknown) will cause your DR account to be archived.  
Keep your personal information current.  Enter the official Training Certification Number.  DOEHRS-HC version at the test 
site.  ISSO (MID).  Supervisors Name enter the Regional Audiologist or senior Audio Technician with their phone 
number.  You need to know who the Regional Audiologist is that covers your location. 
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Justification for Access is the first one in the dropdown window (upload/download from DOEHRS-HC DR).  
Additional access can be provided, contact your Regional Audiologist for assistance. 

  

Once completely filled out press Submit Your Account Request button.  Do not press submit more than one time.  
If complete the following message will appear.  If not there, review the application for missing data.  Applications are 
normally approved within 2 workdays.  You will receive an email allowing you temporary access the DOEHRS-HC DR.  
You will need to login directly to the DR and create a password (good for 60 days). Your CAC certificates will be associated 
with your DR user account. 

 

DOEHRS-HC DR ACCOUNT REQUEST QUIZ 

1.  Why is a DOEHRS-HC DR account required for Audio Technicians? 

2.  Can you use a civilian email account for your DOEHRS-HC DR account? 

3.  What “verification” data is required for a forgotten password? 

4.  Where do you enter your Regional Audiologist information? 

5.  What initial justification do you give for the account application? 
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DOEHRS-HC (DR Data Export) 

Class 10 minutes/Practicum 5 minutes 

There are 2 ways to export data to the DOEHRS-HC DR.  Exporting data to the DOEHRS-HC DR, (required by 
regulation) can be done from an internet connected or a non-internet connected computer.  DR Exports are done daily from 
an internet-connected computer and weekly from a non-internet connected computer (or in conjunction with testing).  
DOEHRS-HC DR upload history should be checked frequently by the individual or by those who have a higher DOEHRS-
HC DR User Privilege.  All Audio technicians are required to have a DOEHRS-HC DR account. 

An Export Reminder will appear whenever you open and log into the DOEHRS-HC application if you have records 
that need to be exported.  It will let you know when the last export occurred and if connected to the internet - allow you to 
select to export the records immediately or if not connected the internet - recommend doing an export as soon as possible. 

‘Export to DR’ function should be done once a day from each DOEHRS work satation.   

Connected to the Internet      

Not connected to the Internet      

Any communication with the DR requires a DOEHRS-HC DR user account/CAC certificates.  
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If your DR user account doesn’t have your certificates or if the CAC filter is down you will get an error message. 

    

To Export Data from an Internet connected workstation.  Click View >  Options.  Make sure the "Connected to the 
Internet" box is checked. Click "Close." 

      

Click Data>Export to DR.  Export progress will occur.  This can be very fast or slow depending on the amount of 
records that need to be exported and your local bandwidth. 
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Export Complete screen will appear with a summary of the export file.  If there are any problems with the export 
progress, Error prompts may appear.  Try the export at a latter time. 

 

To Export Data from a non-Internet connected workstation: Go to View >  Options.  Ensure the "Connected to the 
Internet" box is not checked. 

      

Click Data> Export to DR.  Save the Zipped file to the necessary media source:  If you are going to take this file to 
another workstation in a non-networked environment, save the file to a CD-RW, depending on the size of the file.  If you 
have a Local Area Network (LAN) that both your workstation and the Internet-enabled workstation are on, save the file 
somewhere on the LAN where it can easily be retrieved by the Internet-enabled workstation.  The software automatically 
names the file, You will not be able to change the File name in the Save process.  DO NOT change the file name prior 
to uploading it to the DR. 
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Software will extract the records for export.  After a few moments, the File Export Ready window will appear.  
Click "Print" to print the instructions presented on the window. Click OK to close this window.  Then, the Export Complete 
window will appear. Click "Print" to print the information presented on the screen. Click OK 

 

      

Log into the DR.  Go to DOEHRS HC>Export Data.  You can also check your upload history from this location. 

 

Your profile information will appear.  At the bottom will be an Export File selection window, press browse to search 
for the export file. 
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Upload file must be a zip file.  Other type files may give you error prompts. 

 

Once you find the correct .ZIP file. Select the file.  Press Open. Press upload. 

  

Upload Successful screen will appear. 

 

The next time DOEHRS-HC is started (regardless of user), an Export Reminder window will appear.  If you select 
No, the records from the export will be un-flagged and will be included in any subsequent DR export.  Select no if you don’t 
know if the export was successful.  If you select Yes, the data records will be flagged as exported and will not be included 
in the next or future exports unless you edit the record. 

    

The user who conducted the DOEHRS-HC DR export, either from an internet connected or non-internet connected 
will receive an email that the file was successfully received.  That does not mean it was processed and didn’t have errors.  
Each technician should check the status of their upload history in the DR for process date and status of the export. 
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An email will go to every user that has a successfully received upload at the DR. This does not mean it will 
process successfully. 

 

 To ensure data is processing correctly, at the beginning of each month do a local export of the previous 
months data and load it directly to the DR. 

DOEHRS-HC (DR Data Export) Quiz 

1.  How often are exports to the DR done on an internet-connected computer? 

 

2.  How often are exports to the DR done from a non-internet connected computer?                              
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DOEHRS-HC (DR Inquiry) 

Class 15 minutes 

A DR Inquiry is a query of the DOEHRS-HC DR for patient records.  Any records that are in the DR can be 
downloaded into DOEHRS-HC.  The DOEHRS-HC software needs to be connected to the internet to inquiry records from 
the DR into DOEHRS-HC. This communication is done via the CAC certificates/DR user account. 

lick Data>DR Inquire.  Request Records From DR screen will appear.  You can choose from the patients in your 
database to bring back more data or enter a SSN and press Add New.  Up to 10 patient SSN can be queried at a time. Once all 
the SSNs have been entered press Submit. 

 

If you have not already communicated with the DR when you logged into the application the software will now 
communicate with the DR with your CAC certificates.  You may be required to enter your pin.  
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Inquire will commence.  Import will complete and display how many records were brought in.  This could have been 
87 records for 1 patient or any variation with the patients that were submitted.  All DR inquired 2215/2216/NHC forms can 
be printed, but not edited if they weren’t created on the local database. 

 

      

Your DOEHRS-DR account may become locked and/or archived.  Inform your Regional Audiologist or their 
representative if your account is inactive, they may be able to unlock/unarchive your DR user account or submit a request to: 
https://doehrswww.apgea.army.mil/doehrsdr/pub/RequestUnlock_input.action 

DR Inquiries happen automatically and individually in the Run Test screen (connected to the internet).  Enter the 
patient SSN in the Run Test screen and press tab or enter.  DR Inquiry process occurs immediately.  Import routine works the 
same as the DR Inquiry window.  Patient data downloaded 6 records, including the reference. 

 

Always check to ensure the correct reference is used for periodic tests. 

DOEHRS-HC (DR Inquiry) QUIZ 

1.  How many SSN can be entered into the Request Records from DR screen? 

2.  Who should you (USN) contact to unlock your DOEHRS-HC DR account?  

https://doehrswww.apgea.army.mil/doehrsdr/pub/RequestUnlock_input.action
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DOEHRS-HC (Lookup Table Update) 

Class 10 minutes 

Lookup Table Update occurs monthly and is normally available for download the first working day of each month.  
Table updates the selections that are available in DOEHRS-HC dropdown windows.  The update can be manually 
downloaded and executed or DOEHRS-HC can automatically retrieve it and then execute it. 

DOEHRS-HC will automatically check for Lookup Table updates.  The computer must be connected to the Internet 
in order to download these updates.  A valid and current DR account is required for the technician logging in.  DOEHRS-HC 
will automatically check the DOEHRS database upon your login.  If the last update is one month or older, the software 
will automatically ask if you want to check for a Lookup Table update.  Select Yes. 

Not connected to the internet    

Connected to the Internet    

You can also start the process manually either from the DR or with saved update file (Locally). 

 

If connected to the internet, the Lookup Table Update Process occurs: Sending Request for Lookup/updating local 
data/complete. 

  

Update is very quick normally only a few seconds.  Once completed press OK. 

If the DOEHRS-HC DR secure connection does not happen, the software will inform you to try again later or try 
another method of downloading the Update Patch. 
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Lookup Table Update from a non-internet connected computer.  When logging into a non-internet computer the 
Lookup Table Update will tell you the date the DOEHRS-HC was last updated.  Download the Lookup Table Update from 
DOEHRS-HC DR and place on a transferable device.  Log into DOEHRS-HC DR.  Click on DOEHRS HC>HC Patches. 

 

DOEHRS-HC Software Downloads will appear.  Ensure you select the correct file.  There are both updates and 
upgrades/installation software and multiple versions may be present. Once selected click download and save as. Remember 
where you saved the file as you will need to access it via the DOEHRS application 
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Update File saved.   

Within DOEHRS-HC, Go to: Lookup Table Update>Update from Local select and open file. 
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Application will update. 

  

To Verify Lookup Table Version Go to Help>About DOEHRS-HC.  About DOEHRS-HC screen will appear.  
Visible are the version and Lookup Table Date. 

 

 

Conduct an update if a more recent update is available.  Go to: Desktop>Audio Certification Class>4.1.1.4 
Updates select the latest update. 

DOEHRS-HC (Lookup Table Update) QUIZ 

1.  Why do Lookup Table Updates? 

 

2.  How often does the Lookup Table Update need to occur? 

 

3.  How long does the Lookup Table Update take to process?  
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DOEHRS-HC (Export/Import Data Locally) 

Class 10 minutes/Practicum 5 minutes 

DOEHRS-HC data can be transferred (exported/imported) from/to other DOEHRS-HC test sites.  This transfer 
allows you to send complete hearing tests to other applicable locations.  It will save time, increase accuracy and help 
maintain the integrity of the DOEHRS-HC data.  It can provide patient demographic data and previous hearing tests needed 
to conduct periodic or follow-up testing.  For training purposes, this process simulates how a DR Inquiry occurs and 
affects the local database. 

Go to Data>Export to Workstation 

 

By Date Range.  Date Range Window also appears after selecting data for UIC/WIC and Installation Exports.  By 
IDN 
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By UIC/WIC, Choose DOD Component from pick-list to see single DOD component choices.  Highlight your 
selection, Use CTRL + Left Click to select more than one choice.  By Installation, Choose DOD Component from pick-list to 
see single DOD component choices.  Highlight your selection, Use CTRL + Left Click to select more than one choice. 

      

Once selected, Use “Save in” to select where to save file, removable Drive if you are going to transport file.  File 
automatically named and zipped.  Export process starts, creating Zip File. Below we are export by IDN. All exported files 
process is the same. 
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Export Summary appears, all receipt information including location of file is available when printed. 

 

Demographic Data Only: reduces data entry if you have a source, e.g., personnel system, which can give you the 
necessary information.  

From Legacy Database is to be used only when bring data from 3.2.0.112 into a 4.1 database.   

From Local Database: allows you to share data from the DOEHRS DR or one DOEHRS-HC computer to another, 
eliminating the need to manually enter data if further testing is required (MOHCAT/SHIPS).  Importing DOEHRS-HC 
hearing test data including thresholds & demographics.  Go to Data>Import Data>From Local Database.  Select location 
where file has been placed.  Identify the file location and name, it could be a .ZIP or .MDB file so you may need to use the 
“drop down” file type to change the selection.  Once the file is located select it and click “Open”.  
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Import Records from Local Database appears.  SSN, Patient Name and number of tests are displayed.  You can 
import by IDN (SSN), UIC/WIC, Select All or conduct a specific search by column. Select all and press Import.  Once 
selected, press Import, Import process begins and is successful.  Click OK and Close Import Records Screen 

   

    

If the file is zipped, you need to change the file type to zip to conduct your search.  Once selected it will unzip 
automatically. 
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DOEHRS-HC (Export/Import Data Locally) QUIZ 

1.  Name at least three reasons for transferring data locally. 

 

2.  What is the difference between importing: Demographic Data only, From Local Database and From Legacy Database? 

 

DOEHRS-HC (Export/Import Data Locally) PRACTICUM 

Conduct a Data Import, (local database).  DOEHRSHC Database file is located on the Desktop in folder titled: Audio 
Certification Class>Student Local Import Practicum.  Import will simulate a DR Inquiry.   

If done correctly 108 records should transfer. 
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DOEHRS-HC PATIENT DEMOGRAPHIC DATA FORMS (Practicum) 

Test the following patients.  To simulate a patient the BAS or your partner may be used.  Some patients’ data 
may be easier to enter than others.  Be prepared to discuss problems that occurred and what you did to test the 
patient.  Practice manually testing some frequencies.  Take notes (for discussion) at the bottom of each page. 

 

Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 



106 

 

 

Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 
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Test type selected/reason: 

Changes made from previous patient data: 

 

Write down any issues/problems that you had: 

 

Answered Questions: 

To prepare for the practical exam, students conduct a final back-
up of their database to the desktop.  Do not shut down computer 

as it needs to be set up for the practical exam. 


